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4TISECURITY
Hardware requirements 

 • Personal Computer with Pentium processor >400 MHz  

 • 128 MB RAM

 • SVGA graphics card with resolution 800x600  

 • CD-ROM unit 

 • Mouse 

Software requirements

 • Windows 98 or higher Internet Explorer 5.5 or higher. 

Space used on hard-disk  

 • 8 Mbyte. 
Please note: The TiSecurity 
program is the essential 
tool for the configuration 
of the 3500/3500N and 
3500 GSM Burglar alarm 
Unit.
The content of this program 
is under the exclusive 
rights of Bticino SpA.

Follow this procedure to install the TiSecurity program:  

1.  Insert the CD-ROM in the drive;

2.  After displaying the main page in the web format, select “Install TiSecurity”;

3.  The installation program will now copy the system files necessary for the execution of 
the TiSecurity program. The following screens will be displayed after confirming the 
operations on each occasion.

2. Installation

> Select the installation kit language

> Click the Ok button

1. Hardware 
and Software 
requirements 
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The following screen will appear 

> Click the Next button 

> Click Next to install the program in the default directory  
 “c:\Programmi\Bticino\TiSecurity_0201”

> Click Browse to select the required path 

Or

The following screen will appear 
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The following screen will appear 

> Click Next if you are ready to install TiSecurity  

Or 

>  Click Back to return to the previous screen 

The following screen will appear

> Select the TiSecurity interface language 

>  Click the Next button 
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The installation of the program will now begin. 

Depending on the operating system setup in use, it may be necessary to restart the 
system.  

> Click Finish to end the process 
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3. Basic concepts The TiSecurity software is used for the configuration of the 3500/3500N and the 3500 GSM 

Burglar alarm Units which combine the burglar alarm and telephone dialing device into one 
device. The first step is to select, through the first screen, the type of project, in other words 
whether the Unit uses a dialing device on the PSTN line (item 3500/3500N) or a dialing device 
on the PSTN and GSM line (item 3500 GSM). 

After opening the program, the following screen will appear: 

3.1 Menus and general buttons for selecting functions 

The main functions that can be executed with TiSecurity can be selected by using the icons 
in the toolbar or by opening drop-down menus, thus selecting the various options.  
Many functions can be selected both from the toolbar and from the drop-down menus; 
furthermore, for some functions, it is possible to use hot keys.  
For instance:  
to create a new project, it is possible to select New from the File drop-down menu, from the 
toolbar and from the keyboard by using the keys Ctrl +N.  

The followings functions are included in the toolbar:  

 Please note: For proper 
functioning of the software, 
the 3500 Burglar Alarm 
must be installed accor-
ding to the indications 
specified in the instructions 
sheet supplied with the 
device.  

This manual will show you how to perform the configuration of a Unit item 3500/3500N; 
the configuration functions of a 3500GSM Unit are the same except for those described in 
chapter 10 “Specific configurations for the 3500 GSM Unit”. 

Depending on the technician and user’s needs, it is possible to begin with a new configuration 
or change an existing configuration.  
In this manual the various screens will refer to the second mode.  

Creating a new configuration:  

• Start TiSecurity  

• Execute and save the configuration 

• Send data to the Unit 

Modifying an existing configuration:  

• Execute the auto-learning function from the Unit 

• Receive data from the Unit

• Edit, if required  

• Send data to the Unit 

However, in order to perform a proper configuration, it is necessary to execute the Unit auto-
learning function before connecting the PC to the unit.  
Furthermore, with TiSecurity, it is possible to update the permanent software of the unit 
(“firmware update”) through new revision procedures distributed by Bticino.  

> Select the type of project 

>  Click the Ok button 
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Create a new 
project 

Save the current 
project 

Opens the 
Parameters section  

Executes connection 
to the Unit 

Opens an existing 
project 

Opens the Voice 
message section 

Selects the serial port of 
the PC to which the Unit 
is connected 

Executes connection to 
the Bticino website 

Select the interface 
language 

The followings functions are included in the drop-down menus:  

“File” menu 

• New  creates a new project 

• Open  opens an existing project 

• Save  Saves the current project 

• Save as (with name)   saves the project after requesting a file name 

• Export configuration    exports the project thus creating a file with extension 
.csv which can be imported into Microsoft Excel® by 
following the procedure described in chapter 11  

• Edit type of project   allows you to switch from a project for 3500 / 3500N 
units to a project for 3500GSM units and vice versa 
without restarting the program;  the work area changes 
according to the choice made (see tables)*.  

  The parameters of the project opened will 
automatically be updated  

• Exit  exits the program  

3500GSM 3500/3500N

Enabled for outgoing calls Any value YES  

Channel priority in outgoing calls Any value Field is eliminated  

GSM Management Any value Field is eliminated  

* Switching from 3500GSM to 3500/3500N 

* Switching from 3500/3500N to 3500GSM 

3500/3500N 3500GSM

Enabled for outgoing calls  Any value  GSM OFF

Channel priority in outgoing calls  None  GSM channel priority  

GSM Management None  PIN GSM = 0000
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“?” menu 

• About...   displays information on the TiSecurity program  

• Supported versions displays information on TiSecurity, hardware 
and software versions of the Unit  

The status bar will contain the following information:  

Current data  

Current time 

Loaded project file  

 “Language” menu

•  Select the TiSecurity interface language 

Type of Unit 

“Edit” menu

• Import messages from project  imports all voice messages from an existing 
project 

• Import configuration data from project  imports all configuration data from an existing 
project 

• Load pre-defined audio messages   retrieves voice messages set up for the Unit 

• Select all messages   selects all messages of the project 

• Select all fixed messages  selects all fixed messages of the project 

“Tools” menu

• Parameters opens the Parameters section 

• Messages opens the Messages section 

• Receive configuration   receives the configuration from the Unit, it is 
active only when connecting to the Unit  

• Send configuration  sends the configuration to the Unit, it is active 
only when connecting to the Unit 

• Update Firmware  starts the Unit firmware update procedure  

• Connection to Unit  executes connection to the Unit 
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> Select Import messages from project from the Edit menu 

> Select the project file (. jai) from where you want to import the messages  

> Click the Open button 

When the procedure has been completed, the imported messages will appear 

4.1 Importing voice messages 

This function allows you to import voice messages from a previously saved project.  

The following screen will appear 

4. Importing data from 
an existing project 

It is possible to import data (configuration parameters and voice messages) from a 
previously saved external project file.  

Please note: it is recommend 
t o  s a v e  t h e  c u r re n t 
configuration file of before 
starting the procedure.
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Please note: it is recommend 
t o  s a v e  t h e  c u r re n t 
configuration file of before 
starting the procedure. 

> Select Import configuration data from project from the Edit menu 

> Select the project file (. jai) from where you want to import the configuration 

> Click the Open button 

When the procedure has been completed, the new configuration will appear 

4.2 Importing configuration data 

This function allows you to import configuration parameters from a previously saved 
project. 

The following screen will appear 
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MAINTENANCE
Language
Key program
System test
Learning

system

system

The following message will appear 

5. Connecting to the 
Unit 

To access some functions (e.g. Receive configuration, Send messages, etc.) there must 
be a connection between the PC where “TiSecurity” is installed and the Unit. 
This connection can be achieved through the Connection to Unit function. 

>   Execute the required operations and then click OK  

Select the maintenance menu 
of the Unit and start the auto-
learning function  

Connect the programming cable to a 
serial port of the PC and to the 6–way 
connector of the Unit  

Programming cable 
Item 335919 

Click the OK button 

> From the Port drop-down menu, select the serial port address of the PC you want to 
connect the Unit to (COM1, COM2, etc.).  

> Select Connection to Unit from the Tools menu 

Flip the slide switch 
to off  

Slide switch  
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When connecting to the Unit, a comparison will be made between the configuration of the 
Unit which, through the auto-learning function previously carried out reflects the real system, 
and the configuration of the current project. 
If the configurations are different, the following warning message it will appear:  

> Click Yes to display the details of the differences found  

The data can be exported into a file with extension .csv, which can be imported in Microsoft 
Excel by following the procedure described in chapter 11. 

At this stage, by clicking the Details button, it is possible to display the list of communication 
activities between the personal computer and the unit.  
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6.  Exchanging data 
with the Unit 

When the connection to the Unit has been activated, it will be possible to: 

•  Send/receive configuration parameters

•  Send/receive voice messages

•  Receive the history of events from the unit

Refer to paragraphs “Exchanging configuration parameters with the Unit” and “Exchanging 
voice messages with the Unit” to carry out these functions. 

At the end of the procedure the Connection button will change into Disconnection.  

It is now possible to swap data with the Unit, 

Click Disconnection to stop connection. 

The following message will appear 

> Disconnect the programming cable connector from the Unit 

> Click the OK button 

> Click YES to load the configuration of the system in the Unit  

> Click NO to keep the current project unchanged 

However, there will be a connection to the Unit. 

> The following message will appear if click QUIT 



16TISECURITY

7.1 Work area 

7. Parameters In this section it is possible to execute the Unit parameters configurations. 

The screen referred to the Parameters section displays all typical parameters for the confi-
guration of the Unit, represented hierarchically with a tree structure on the left side. 
On the right side, a specific template for inputting data and for communicating with the Unit 
can be displayed by selecting each element of the hierarchic structure. 
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Data input template 

Receives configuration 
from the Unit 

Send configuration to 
the Unit 

Receives the history of 
events from the Unit 

Data input 
zone 

Help zone  

Communication bar with 
the Unit 

This template includes a top bar where the icons will be highlighted only during the connection 
with the Unit, a bottom zone where information will be displayed to help the user input the 
data and a central part split into two columns, in which the right column is used for inputting 
data.  
The data input procedure will differ depending on the type of data to enter.  

7.1.1 - Data input procedure 

Inputting by typing in data:  

> Click the data input zone 

> The text, if any, will be edited (e.g. Input) 

> Type in new data 

Inputting data with the drop-down menu: 

> Click the data input zone; the  button will appear 

> A drop-down menu will appear after clicking the button 

> Select any data available 

Displays information  

Fixed zone



18TISECURITY
Inputting data with the sliding menu:

> Click the data input zone; the  button will appear  

> Use the button to move through the available data  

Inputting with an independent window: 

> Click the data input zone; the  button will appear 

> An independent window will appear after clicking the button 

> Enter the required data 

> Click OK to close the window 
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7.2 Exchanging configuration parameters with the Unit 

7.2.1 - Receiving configuration parameters 

This function allows you to receive the configuration parameters from the Unit. 

> Execute the Connection to Unit procedure 

> Click Receive from the communication bar 

The following screen will appear 

> Click the Yes button 

When the procedure has been completed, the Unit configuration parameters will be available 
in the Parameters section for future verifications/changes, if required.  
If it is necessary to change the Unit parameters, execute the procedure Sending configuration 
parameters to activate them.  

Please note: it is recommend 
t o  s a v e  t h e  c u r r e n t 
configuration file of before 
starting the procedure. 
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7.2.2 - Sending configuration parameters 

This function allows you to send the configuration parameters to the Unit. 

> Execute the Connection to Unit procedure 

> Click Send from the communication bar 

The following screen will appear 

> Click the Yes button 

By clicking Yes, it will be possible to display the discrepancies found. 

When sending the parameters, a comparison will be made between the configuration of the 
Unit and the configuration of the current project.  
If the configurations are different, the following warning message it will appear: 



21

If you click No when the warning message appears or Quit in the error window, the following 
message will appear:  

> Click the Force button to send the parameters of the current project to the Unit and then 
change its parameters.  

> Click the Align button to change the parameters of the current project, thereby aligning 
them with the Unit.  

In the first case, when the procedure has been completed, the parameters will be enabled 
in the Unit configuration.  
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7.2.3 - Receiving the history of events 

This function allows you to receive the history of events, in other words the events of the 
burglar alarm system recorded in the Unit.  

> Execute the Connection to Unit procedure 

> Click Event memory from the communication bar 

The following screen will appear 

> Click the Yes button 

When the procedure has been completed, you will see a window showing the list of events 
recorded by the Unit in the history of events.  

> Click the Export button to export the event memory into a file  
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The following message will appear: 

> Click the Yes button 

The following screen will appear: 

> Name the file in which the event memory will be stored  

> Click the Save button 
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7.3 Configuration of the Burglar alarm section 

In this section it is possible to set up the part of the Unit related to the burglar alarm 
system.  

The options are as follows: 

• Zones 

• Automations

• User Preferences

• Installer preferences

The tree structure will show the configured components with their number in brackets.  
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7.3.1 - Zones

This screen shows the list of zones in which the burglar alarm system is divided.  
For each zone it is possible to enter a reference name which identifies the zone. 
Entering the description of a zone is possible only after the configuration of at least one 
device belonging to this zone.  

The following paragraphs will describe how to set up devices in different zones;  to perform 
these configurations, the device must be present. 

The present devices will be displayed in red.  
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Common objects 

This screen displays the devices which are common to the whole unit.  
It is possible to indicate the presence of the device and to enter a description. 

Connectors 

This screen displays the connectors included in the burglar alarm system. 
It is possible to signal the presence, activate, enter a description and select a type of 
device.  
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Zone 1...8

This screen displays the devices included in the single zones. 
It is possible to signal the presence, activate, enter a description and select a type of 
device. 

Furthermore, it is possible to enable/disable the activation delay the device can be delayed 
or not depending on the type of device selected and on its firmware version.  

When you click the Information button, you will see a screen which will remind you of how 
the delay time will be set up according to the delay enabling status for the devices of the 
zone.  
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Auxiliaries

This screen displays the devices which are not included in the burglar alarm system (e.g. 
gas leak detector). 
It is possible to signal the presence, activate, enter a description and select a type of 
device. 
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7.3.2 - Automations 

This screen shows the list of automations that can be set up. 
The automation lets you link an execution (set with an Open command) to one specific 
burglar alarm event. 
It is possible to enable/disable the automation, enter a description and select an event to 
be matched with a   to produce the automation required.  

Event 
Depending on the choice made, it is possible to select a type of event from the Type drop-
down menu; the underlying fields will be activated and dealt with later on.  

Data input 
When you click inside the data input zone (data input field) of the Run option, an Open 
Command window will be opened whereby it is possible (through a guided or manual insertion) 
to determine the Open Command to be combined with the previously selected event.  

Guided Insertion:  

> Select the Open Command from the drop-down menu and select the data related to the 
system, to thae action and to the destination.  

> Click the Ok button 

Manual Insertion:  

> Type in the Open Web Net code to create the Open Command 

> Click the Ok button 

Data input field 

Event Field 
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Type of event - Alarm  

> Select the event related to the type of alarm from the drop-down menu 

Type of event - Technical 

> Select the event related to the technical type from the drop-down menu 

Type of event – Power lack 

> Select the event related to the power lack type from the drop-down menu 

Type of event – Enable/Disable (Insertion/De-insertion)

> Select the event related to the type of enabling from the drop-down menu 

The associated field will be activated by selecting the division event 

> Click the  button 

> An independent window will be opened, select the zones to be divided  

> Click Ok  

The associated field will be activated by selecting the connector event 

> Type in the connector number  
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Type of event - Date 

The associated field will be activated by selecting the Date event from the drop-down 
menu 

> Click the  button

> An independent window will be opened; type in the date and the time of activation of the 
data input entered in the Run field 

> Click Ok

Type of event – Event from system 

The associated field will be activated by selecting “Event from system” from the drop-down 
menu. 

> Click the  button

> An independent window will be opened, enter the Open Command 

> Click Ok

With this type of event it is possible to match two data inputs (open-open): the first through 
the independent window which can be activated from the Event field whereas the second 
as per the other type of event from the Run field.  
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Example of automation  

- Lights ON in “Room 3” at every trespassing alarm. 

1

2

3

4

5

Procedure:

1  Enable automation 

2  Type in the reference name of the automation (e.g. Staircase lights) 

3  Select type of event - Alarm 

4  Select Intrusion event  

5  Enter the Open command which will be activated after the Intrusion event  

Guided Insertion: 

> Select System LIGHTING  
>  Select Action   ON  
>  Select Destination  ROOM 3  

Manual Insertion:

> Type in *1*1*3##

> Click the Ok button 

> Click the Ok button 
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Example of automation 

- Lower the blinds at 22:30 h every day. 

1

2

3

4

5

Procedure: 

1  Attivare l’automazione

1  Enable automation 

2  Type in the reference name of the automation (e.g. Evening) 

3  Select type of event - Date 

Guided Insertion: 

> Select System  AUTOMATISMS 
> Select Action   DOWN 
> Select Destination  GENERAL 

Manual Insertion: 

> Type in *2*2*0##

> Click the Ok button 

> Click the Ok button 

5  Enter the Open command which will be activated after the Date event 

4  Enter the date and time 
 To set up the automation to a preset time every day, enter ** in the Day/Month/Year 

fields.  

> Click the Ok button 
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Example of automation 

- Lights OFF Room 4 when the blind is rolled up (e.g. light point 11).  

1

2

3

4

5

Procedure: 

1  Enable automation 

2  Type in the reference name of the automation (e.g. Day) 

3  Select type of event – Event from system 

4  Enter the Open command which will be the automation event. 

Guided Insertion: 

> Select System   LIGHTING 
>  Select Action    OFF 
>  Select Destination   ROOM 4 

Manual Insertion: 

> Type in  *1*0*4##

> Click the Ok button 

> Click the Ok button 

5  Enter the Open command which will be the data input of the automation. 

Guided Insertion: 

> Select System   AUTOMATISMS 
> Select Action    UP 
> Select Destination   LIGHT POINT 11 

> Click the Ok button 

Manual Insertion: 

> Type in  *2*1*11##

> Click the Ok button 
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7.3.3 - User Preferences 

This screen displays the user’s preferences 
It is possible to change all preferences in the procedures described hereinafter.  

It enables you to enter or change the user code of the Unit.  
In the basic configuration the user and maintenance code are the same; they also enable 
you to access all menus of the Unit.  
Changing the user code will also automatically update the maintenance code as long as the 
latter is not modified.  
> Type in the user code in the required field 

Sets the duration of the siren sound in case of an alarm due to tampering or problems related 
to the SCS signal reception.  
> Select one of the proposed values from the drop-down menu 

Sets the duration of the siren sound in case of an alarm.  
> Select one of the proposed values from the drop-down menu 

Assigns the delay time for the activation of the sensors of zone 1. This allows you to pass 
through zone 1 before disconnecting the system and without activating the alarm.  
> Select the delay duration from the drop-down menu 

Assigns the delay time for the activation of the sensors of zone 1. This allows you to pass 
through zone 1 after enabling the system and without activating the alarm. 
> Select the delay duration from the drop-down menu 

Adjusts the display contrast of the Unit. 
> Adjust the contrast with the arrows by clicking in the field.  
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7.3.4 - Installer Preferences 

This screen displays the installer’s preferences. 
It is possible to change all preferences in the procedures described hereinafter. 

Adjusts the display language of the Unit as well as the voice messages. 
> Select one of the proposed languages from the drop-down menu 

It enables you to enter or change the installer code (maintenance code). 
In the basic configuration the user and maintenance code are the same; they also enable 
you to access all menus of the Unit. 
This function enables you to distinguish them in order to allow only the installer to access 
the Maintenance menu of the Unit. 
> Type in the maintenance code in the required field 

Enables/disables the ON (3 flash) and OFF (1 flash) signaling (through the flash of the external 
siren) of the burglar alarm system.  
> Select Yes/No from the drop-down menu. 

Enables/disables the periodic check of the interconnections between the Unit and devices 
connected 
> Select Activ./Deactiv. from the drop-down menu. 

Sets the unit as a Master clock (sends the time update to all MyHome devices provided with 
a clock, such as Touch Screen, Web Server, etc.) or as a Slave (receives the time update 
from other devices). 
Only one device of the MyHome system can be set as a Master. 
> Select Master/Slave from the drop-down menu. 
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7.4 Configuration of the Dialing device section 

In this section it is possible to set up the part of the Unit related to the Telephone Dialing 
Device. 

The options are as follows: 

• Telephone number directory 

• Set calls 

• Telephone functions 

• Telephone controls 

The tree structure will show the configured components with their number in brackets. 
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7.4.1 - Telephone number directory 

In this screen it is possible to set up the jolly number and the 10 telephone numbers of the 
directory.  

Jolly number 

It is the first telephone number called by the Unit when any type of alarm is detected (intrusion, 
failure, technical alarm). If the MyHome portal is enabled, make sure it matches the telephone 
number of the portal.  
It is possible to enable/disable, enter a description and a telephone number. 

Telephone number 1...10

It is possible to store the 10 telephone numbers of the directory in these fields. The numbers 
entered will be able to be used (e.g. for being included in the 4 numbers to be called according 
to the type of alarm recorded by the burglar alarm system – see “Outgoing calls”), only if 
enabled in this template.  
It is possible to enable/disable, enter a description and a telephone number. 
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7.4.2 - Setting up calls 

This screen lets you match some telephone numbers stored in the directory (max 4 numbers) 
with the alarm events detectable by the burglar alarm or any specific Open event chosen 
by the user. 
When an event occurs, whether it is detected by the burglar alarm system or programmed 
by the user, the Unit will call the telephone numbers corresponding to that event and will 
communicate, through a voice message (see the chapter “Messages”), the type of alarm 
that has occurred.  

Calls following a System alarm event and System failure  

> Enable/disable the event  

>  Select the telephone numbers of the directory to be matched with the event from the 
drop-down menu 

Calls following an Open event 

> Enable/disable the event 

>  Type in the reference name 

> Enter the OPEN command which will initiate the call 

> Select the telephone numbers of the directory to be matched with the event from the 
drop-down menu 

 Please note: the telephone 
numbers to be matched will 
appear in the drop-down 
menus only if previously 
enabled in the telephone 
number Directory screen 



40TISECURITY
7.4.3 - Telephone functions 

This screen displays the telephone functions that can be customized. 
It is possible to change all functions in the procedures described hereinafter. 

Enables/disables the dialing device to make telephone calls. 
>ASelect Yes/No from the drop-down menu. 

If this function will be disabled and if the MyHome portal is active, the following message 
will appear:  

> Click the Yes button 

The function is now “Enabled for outgoing calls” and the “MyHome Portal” service is disabled.

Sets the number of rings, after which the dialing device answers a call.If there’s an answering 
machine, the number of rings shall be higher than the one set for the answering system. 
> Select the number of rings from the drop-down menu 

Determines the number of times the dialing device will repeat calls to the numbers from 
which it did not receive an answer.  
> Select the number of cycles from the drop-down menu 

Sets the delay time, following an alarm, before the call cycle is started.  
> Select the delay time from the drop-down menu 
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Lock (Block) 

In this screen it is possible, through the options available in the “Enabling” drop-down menu, 
to decide not to lock the open commands remotely, to lock all of them or to set up to 4 codes 
to prevent specific open commands from being executed remotely.  

> Enter a description for the filter 

>  Enter the Open command you 
want to lock. 

> Select type of lock from the “Enabling” drop-down menu. 

If you select “Customized” it will be possible to define the filters described hereinafter.  

Allows you to set the type of line. 
> Select DTMF (tone dialing line) or PULSE (pulse dialing line) from the drop-down menu  

Sets the time between the moment power goes off and the starting time of the Unit telephone 
calls. 
> Select the waiting time from the drop-down menu 

Enables/disables the activation/deactivation of the burglar alarm system from the telephone 
line. 
> Select Yes/No from the drop-down menu. 

Informs the dialing device that an answering machine is installed on the telephone line. 
> Select Yes/No from the drop-down menu.

Enables/Disables the possibility to send remote voice messages to the room (via the Unit 
loudspeaker and if connected from the sound system) and the room listening function via 
the Unit microphone. 
> Select Yes/No from the drop-down menu. 

Assigns the waiting time between one call and the next. 
> Select the waiting time from the drop-down menu 
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MyHome Portal 

This screen displays the setups for managing the system through the MyHome portal. 

> Enable/disable the presence of the MyHome portal services.  

> Type in the password OPEN to access the system. 

> Type in the System ID provided by the MyHome portal.  

After enabling the portal, if the function “Enabled for outgoing calls” in the “Telephone 
functions screen is disabled, the following message will appear  

> Execute the operations described in the message and repeat the operation  

if the function” Enabled for outgoing calls” is enabled, the telephone number of the portal 
will be set as the jolly number.  
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7.4.4 - Telephone commands 

In this screen it is possible to set up telephone commands which can later be executed by 
the user through simplified codes consisting of just 4 digits, through the Unit keypad or by 
telephone. 

> Enable/disable the command 

> Type in the reference name 

> Enter the command open code. 

In this case, by remotely typing in the command 9911, the user will switch on the entrance 
lights whereas if 9901 is typed in, they will switch off. 
The user can record a personalized voice message only for the first 4 telephone commands 
(see chapter “Messages”). 
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8.1 Work area 

8. Messages In this section, it is possible to manage voice messages which are sent from the Unit to 
the set telephone numbers when a particular event occurs or as an answer to telephone 
commands sent by the user. 

The screens in the “Messages” section display the messages related to the type selected in 
the bottom menu (fixed Messages, Presentation, customizable Calls, telephone Commands); 
it is possible to select the various templates by clicking the corresponding buttons. 
The screens are divided into two columns: the tree-structured Message column includes 
the messages whereas in the Content column it is possible to enter a name which identifies 
the message.  
The messages will have a green background.  
At the top part of the screen there is a message management bar and at the bottom there is 
a zone where there will be different information related to the selected message.  

Sends a message to 
the Unit 

Emits a message from the 
Unit loudspeaker 

Receives all messages 
from the Unit 

Imports an 
audio file 

Emits a 
message 

Stops emitting/recording a 
message 

Records a 
message 

Brief description of the message function 

Example of the message voice contents 

Message (message length)  
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8.2 Exchanging voice messages with the Unit 

8.2.1 - Sending voice messages 

This function allows you to send one or more messages to the Unit. 

> Execute the Connection to Unit procedure 

> Select by ticking the box next to the message to be sent 

> Choose Select all messages from the Edit menu or 

 Select all fixed messages as needed 

or select all messages 

> Click Send from the message management bar 

wait until the procedure has been completed 
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8.2.2 - Listening to messages from the Unit loudspeaker 

This function allows you to listen to the message selected from the Unit loudspeaker.  

>  Execute the Connection to Unit procedure 

> Select a message; the message will be highlighted. 

> Click Listen from the message management bar 

The message will be emitted from the Unit loudspeaker.  

8.2.3 - Receiving voice messages 

This function allows you to receive all messages included in the Unit. 

> Execute the Connection to Unit procedure 

> Click Receive from the message management bar 

When the procedure has been completed, the Unit voice messages will be available in the 
Messages section for future verifications/changes, if required. 

> Click the Yes button 

The following message will appear 

 Please note: the messages 
in the current project file 
will be overwritten.  
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8.3 Voice message commands 

8.3.1 - Importing an audio file 

This function allows you to import an audio file. 

> Select a message; the message will be highlighted. 

> Click Import wav from the message management bar 

The following screen will appear 

The installation directory includes the folder “Wave”, in which the voice messages are con-
tained and divided into folders according to the language.  
The audio file must have the following features:  
- maximum duration as per description (... sec.)  
- type .wav 
- sampling: PCM 8Khz 
- resolution: 8 bit Mono 
> Click the Open button 

8.3.2 - Emitting a voice message 

This function allows you to emit a message from the PC loudspeakers 

>  Select a message; the message will be highlighted. 
>  Click Listen from the message management bar. 
 the message will be emitted 
>  Click Stop from the message management bar to stop 

8.3.3 - Recording a voice message 

This function allows you to record a message 

>  Select a message; the message will be highlighted. 
>  Click Record from the message management bar 
> Start recording by speaking in a normal voice from a microphone connected to the PC 
The recording will automatically end when the preset time for the message has elapsed.  

8.3.4 - Retrieving voice messages 

This function allows you to retrieve voice messages set up for the Unit 

>  Select Load pre-defined audio messages from the Edit menu  

The pre-defined audio messages will be retrieved by overwriting those of the current 
project.  

> Select the audio file (. wav) from where you want to import the messages. 
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>  Select Update Firmware from the Tools menu 

9. Update Firmware This function allows you to update the permanent basic software (firmware) in the unit through 
revision procedures distributed by Bticino 

The Download Firmware screen will appear 

Opens an 
update file 

Stops the update 
procedure. 
It is activated after 
loading the file  

Exits the 
screen 

Selects the serial port 
of the PC to which 
the Unit is connected 

Update file loaded Starts the update procedure. 
It is activated after loading the file 

The above commands are also available in the File and Tools drop-down menu.  

>  Click the Select file button 

Displays a template 
containing information 
about the Firmware 

Displays log of 
activities executed 
while downloading 



49

> Select the update file (.fwz) 

> Click the Open button 

The following screen will appear 

The Update button is now available. 

The following message will appear 

Execute the required operations and then click OK 

>  Click the Update button 

>  From the Port drop-down menu, select the serial port of the PC you want to connect the 
Unit to. 
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MAINTENANCE
Language
Key program
System test
Learning

system

system

Select the maintenance menu 
of the Unit 

Connect the programming cable to a 
serial port of the PC and to the 6–way 
connector of the Unit. 
Press the reset button. 

Programming cable 
Item 335919 

Reset button 

>  Disconnect the programming cable connector from the Unit 

>  Click the OK button 

>  Press the Unit reset button. 

The Unit firmware is now updated. 

When the update procedure has been completed, the following message will appear along 
with an audible alert  

Flip the slide switch 
to off 

Slide switch

Click the OK button 
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Once the updating process has been completed it is possible, by clicking on Detail, to display 
a window which lists the activities carried out during the firmware download operation.  
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10.1 Telephone functions 

This screen displays the telephone functions that can be customized. Possible customizations 
are shown only for specific functions concerning the 3500 GSM Unit. 

10.Specific 
configurations of 

 Unit item 3500 
GSM

This section will describe the specific functions for the configuration of a Unit which uses a 
dialing device on a PSTN and GSM line (Unit item 3500 GSM)  
For all other configurations, please refer to the previous chapters.  

The functions that may change or be added compared to the configuration of a 3500 Unit are:  

• Telephone functions 

• GSM Management

Enables/disables the dialing device to make telephone calls on a PSTN and GSM line (On, 
Off), disables only GSM (GSM Off) or disables only PSTN line (PSTN Off). 

> Select On/Off/GSM off/PSTN Off) from the drop-down menu 

If this function will be disabled (only command Off) and if the MyHome portal is active, the 
following message will appear: 

> Click the Yes button 

The function is now “Enabled for outgoing calls” and the “MyHome Portal” service is disabled. 
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Determines which channel is used first in the outgoing calls.  

> Select GSM/PSTN from the drop-down menu 

10.2 GSM Management 

In this screen it is possible to enter the Pin Code of the SIM card inserted in the 3500 GSM 
Unit.  

If the SIM card does not need a Pin Code, do not change the setup (basic “0000”). 
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> The window below will be activated  

> Select “Text file” in the “File type” box 

> Select the . csv file you want to import and then click “Open” 

11.Opening files 
exported from 
Tisercurity in 
Microsoft Excel®  

In order to display files exported from TiSecurity (.csv) it is necessary to use Microsoft 
Excel® (ver. 2000 or higher). Previous versions are not recommended). 

In order to open exported .csv files, follow this procedure: 

> Run the application 

> Select “Open” from the “File” menu 



55

> The configuration (in text format) exported from TiSecurity will be loaded in the Excel 
spreadsheet 
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